L16 - Techniques to Increase Efficiency with PanelView™ Plus 7 Performance Applications

For Classroom Use Only!
Important User Information

This documentation, whether, illustrative, printed, “online” or electronic (hereinafter “Documentation”) is intended for use only as a learning aid when using Rockwell Automation approved demonstration hardware, software and firmware. The Documentation should only be used as a learning tool by qualified professionals.

The variety of uses for the hardware, software and firmware (hereinafter “Products”) described in this Documentation, mandates that those responsible for the application and use of those Products must satisfy themselves that all necessary steps have been taken to ensure that each application and actual use meets all performance and safety requirements, including any applicable laws, regulations, codes and standards in addition to any applicable technical documents.

In no event will Rockwell Automation, Inc., or any of its affiliate or subsidiary companies (hereinafter “Rockwell Automation”) be responsible or liable for any indirect or consequential damages resulting from the use or application of the Products described in this Documentation. Rockwell Automation does not assume responsibility or liability for damages of any kind based on the alleged use of, or reliance on, this Documentation.

No patent liability is assumed by Rockwell Automation with respect to use of information, circuits, equipment, or software described in the Documentation.

Except as specifically agreed in writing as part of a maintenance or support contract, equipment users are responsible for:

• properly using, calibrating, operating, monitoring and maintaining all Products consistent with all Rockwell Automation or third-party provided instructions, warnings, recommendations and documentation;
• ensuring that only properly trained personnel use, operate and maintain the Products at all times;
• staying informed of all Product updates and alerts and implementing all updates and fixes; and
• all other factors affecting the Products that are outside of the direct control of Rockwell Automation.

Reproduction of the contents of the Documentation, in whole or in part, without written permission of Rockwell Automation is prohibited.

Throughout this manual we use the following notes to make you aware of safety considerations:

**WARNING**

Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**IMPORTANT**

Identifies information that is critical for successful application and understanding of the product.

**ATTENTION**

Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attention helps you:

• identify a hazard
• avoid a hazard
• recognize the consequence

**SHOCK HAZARD**

Labels may be located on or inside the drive to alert people that dangerous voltage may be present.

**BURN HAZARD**

Labels may be located on or inside the drive to alert people that surfaces may be dangerous temperatures.
Techniques to Increase Efficiency with PanelView™ Plus 7 Applications

Contents

Before You Begin .................................................................................................................. 6
About this lab ......................................................................................................................... 6
Tools & prerequisites ............................................................................................................ 6
Document conventions .......................................................................................................... 7
PanelView™ Plus 7 ................................................................................................................ 8
FactoryTalk® ViewPoint........................................................................................................ 9
Begin the Lab – Mandatory ............................................................................................... 10
Before You Begin ................................................................................................................ 10
Module 1 – Increase Line Productivity – Runtime User Management................................. 12
Demo ................................................................................................................................... 12
How To .............................................................................................................................. 19
Module 2 – Increase Line Productivity - Managing Machine / Process Parameters with Recipe Manager ......................................................................................................................... 28
Demo ................................................................................................................................... 28
How to .............................................................................................................................. 32
Module 3 – Reduce Travel Cost - Monitor Application Remotely with ViewPoint................. 42
Demo ................................................................................................................................... 42
How To .............................................................................................................................. 47
Module 4 – Reduce Travel Cost & Remote Troubleshooting Capability - Remote Display Access with VNC .......................................................................................................................... 51
Demo ................................................................................................................................... 52
How To .............................................................................................................................. 55
Module 5 – Increase OEE - Log Production Data with DataStore Plus ................................ 58
Demo ................................................................................................................................... 58
How To .............................................................................................................................. 59
Module 6 – Reduce Maintenance Cost - Switch Application Language to Operator’s Native Language ................................................................................................................................. 65
Demo ................................................................................................................................... 65
Before You Begin

About this lab
This lab uses real life plant floor scenarios that take place at a fictitious company called Super Juice. This company makes different flavored juice. The scenarios demonstrate how an engineer can use some of the features in FactoryTalk® View Studio for Machine Edition along with some of the extended capabilities of the PanelView™ Plus 7 terminals to resolve real plant floor issues. The lab then takes you behind the scenes of the demo and shows you how the features were configured. Each scenario is modular and can be done in any order. Users who are not familiar with FactoryTalk® View Studio for Machine Edition or the PanelView™ Plus 7 terminals have the ability to work through a basic application lab in Appendix A.

This lab takes approximately 1 hour to complete.

Who should complete this lab
This lab is intended for both new users and users with existing experience using FactoryTalk® View Machine Edition. The lab’s content is designed to demonstrate the capabilities of both Machine Edition and the PanelView™ Plus terminals. New users can go directly to the appendix and work through a hands on lab to create a basic application. If you are an experienced FactoryTalk® View Studio for Machine Edition user or HMI designer, you may be dissatisfied with this lab.

How the lab is organized
The lab is organized into a Great Demo concept with 9 different scenarios. Each scenario contains a demo and then a How To section. The How To is comprised of descriptions for each of the demo features, going behind the scenes and explaining how the application was configured to achieve the desired results. There is also an appendix section for those who are new to FactoryTalk® View Machine Edition and PanelView™ Plus and would like more detail on the fundamentals of creating an application.

Tools & prerequisites
To complete this lab you must use the following hardware and software:

- A Microsoft Windows® 7 64-bit computer
- Ethernet connection between computer and PanelView™ Plus 7 terminal
- FactoryTalk® View Machine Edition Studio v8.00.00
- FactoryTalk® Services Platform 2.73
- RSLinx™ Enterprise v5.70
- RSLinx™ Classic v3.73
- Studio 5000™ Logix Designer v21.03
- SoftLogix 5800 v21.03
- Microsoft Excel® 2013 or newer
- PanelView™ Plus 7 terminal with FactoryTalk® View Machine Edition Station v8.00 and OS v2.40
- FactoryTalk® ViewPoint V8.00
- Silverlight v5 or greater
- ArGoSoft Mail Server Freeware
Document conventions

Throughout this workbook, we have used the following conventions to help guide you through the lab materials.

<table>
<thead>
<tr>
<th>This style or symbol:</th>
<th>Indicates:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Words shown in bold italics (e.g., RSLogix 5000 or OK)</td>
<td>Any item or button that you must select, click on, or a menu name from which you must choose an option or command. This will be an actual name of an item that you see on your screen or in an example.</td>
</tr>
<tr>
<td>Words shown in bold (e.g., Communication Setup)</td>
<td>This is the name of an item that you see on your screen or in an example.</td>
</tr>
<tr>
<td>Words shown underlined and bold (e.g., Controller1)</td>
<td>An entry that you must type in the specified field. This is information that you must supply based on your application (e.g., a variable). <strong>Note:</strong> When you type the text in the field, remember that you do not need to type the quotes; simply type the words that are contained within them (e.g., Controller1).</td>
</tr>
<tr>
<td>This is sample text.</td>
<td>Text that appears inside of a gray box is supplemental information regarding the lab materials or learning goals; the information is not required for you to complete the lab exercises. The supplemental text may provide you with helpful hints that can make it easier for you to use this product.</td>
</tr>
</tbody>
</table>

**Note:** If the mouse button is not specified in the text, you should click on the left mouse button.

FactoryTalk® View Machine Edition

FactoryTalk® View Machine Edition (ME) is a machine-level HMI product that supports both open and dedicated operator interface solutions for monitoring and controlling individual machines or small processes. It provides a consistent operator interface across multiple platforms, including Microsoft® Windows® CE and Microsoft® Windows® 7 solutions.

FactoryTalk View Machine Edition contains two components:

- **FactoryTalk® View Studio** - This is the development environment containing the tools you need for creating all aspects of a human-machine interface (HMI), including graphic displays, trends, alarm reporting and real-time animation. It also provides tools for testing individual displays and entire applications. When development is completed, a run-time (.MER) file is created to run on a PanelView™ Plus or personal computer.

- **FactoryTalk® View Machine Edition Station** - This is the run-time environment. FactoryTalk View Machine Edition Station executes the run-time (.MER file) application. FactoryTalk View Machine Edition Station is embedded in PanelView™ Plus terminals. Run-time applications may also be executed on a personal computer. Executing run-time applications on a personal computer requires additional software licenses.
PanelView™ Plus 7

The PanelView™ Plus are operator interface terminals designed to optimize system development, performance, and efficiency. The PanelView™ Plus 7 line of terminals is the latest addition to Rockwell Automation’s versatile family of Allen-Bradley PanelView™ operator interface displays for machine level operator terminal applications in industrial environments.

The PanelView™ Plus 7 line extends the portfolio with increased display resolutions while still supporting a known design environment – FactoryTalk® View Machine Edition. Please reference the following tables for more information regarding the PanelView™ Plus 7 Performance and the entire PanelView™ Plus 7 family.
FactoryTalk® ViewPoint

FactoryTalk® ViewPoint is an add-on to FactoryTalk® View ME running on PanelView™ Plus that provides for a fully scalable, fully animated, read-only view of existing applications from a Web browser.

To make information about your plant or process available on demand from a Web browser in your office, home, or hotel, all you have to do is select the FactoryTalk® View graphic displays you want to make ready for the Web, and then publish the displays to the FactoryTalk® ViewPoint Server which runs on a PanelView™ Plus.

There is no installation of any Rockwell Software products on the browser computer. All you need to connect to a published FactoryTalk® ViewPoint Web application is the name (or IP address) of the PanelView™ Plus hosting the FactoryTalk® ViewPoint Server that stores the application.

Once you enter a simple address directly into your Web browser using the name or IP address, the browser will connect to the published web application and open the initial display selected. Use navigation buttons in the application to view other published displays, or use the web browser's navigation tools.

What is Silverlight?

FactoryTalk® ViewPoint uses Microsoft's Silverlight technology to visualize FactoryTalk® View content in a browser. Microsoft Silverlight is a Web presentation technology that was created to run on a variety of platforms to deliver applications for the Web. It enables the creation of rich, visually stunning and interactive experiences that can run everywhere: within browsers and on multiple devices and desktop operating systems.

If Silverlight is not installed on a client computer that connects to the PanelView™ Plus and the client computer is connected to the internet, the client computer is automatically redirected to the Microsoft Silverlight installation site for download. If the client computer is not connected to the internet, instructions for installing Silverlight are automatically provided in the browser.

For the purpose of this lab, Silverlight has already been installed.
Begin the Lab – Mandatory

Before You Begin

The lab is configured in a Great Demo style. There are 9 scenarios that demonstrate different features of FactoryTalk View Machine Edition 8.0 and the PanelView Plus 7 terminal. Each scenario contains a demo followed by a section detailing how that part of the demo was configured. You will load and run the demo application on the PanelView Plus 7 terminal. You will then configure and explore the FactoryTalk® View Machine Edition application that was used to create the demo.

You will use the SuperJuiceDemo.mer and the PanelView™ Plus 7 for all the demo sections of the scenarios.

1. Launch FTViewME Station by double clicking the icon on the PanelView™ Plus 7 terminal desktop.

2. Click  .

3. Select SuperJuiceDemo.mer and click  .

4. Click  to replace the terminal’s current communication configuration.

5. Click  .

It may take up to 1 minute for the application to load and run. Once the application is running, if there are any alarm messages, just click the Close button to close the alarm banner.
Now let’s launch FactoryTalk View Studio on the lab PC and open the Super Juice Partial application. We will use this application to explore how the Super Juice demo was created.

1. From the **Start** menu, select *FactoryTalk View Studio*.

![Start menu]

2. Select the **SuperJuicePartial** application and click **Open**.

![Application selection]

---

1 of 150
Module 1 – Increase Line Productivity – Runtime User Management

Business Issue
Anytime a FactoryTalk Security user was added or deleted, or the password needed to be changed for an account, the change was done offline, using View Studio. Then a new runtime file was generated and redeployed. This caused unnecessary downtime.

Additionally, there is now a desire to use a RFID reader with single sign-on capability rather than having the operator type in his user name and password.

Solution
The Plant Manager, Ralph, learns of the runtime user management features available in version 8.0 of FactoryTalk View Machine Edition. Ralph is now able to manage user accounts on the terminal, during runtime, rather than having to back into the Machine Edition project, create a new runtime file and then download the new runtime file, therefore saving quite a bit of time.

Ralph decided to use a RFID reader from a company called RFIDeas. The RFID reader will save time and eliminate frustration when logging into the HMI application because the operators will no longer need to type in their user names and passwords.

Demo

1. From the Plant Summary display on the PanelView Plus 7 terminal, click the Login icon in the title bar.

   Login using the Supervisor account:
   User name: su1
   Password: su1

   The unlock icon will appear and user SU1 will display as the current logged in user.
2. Click the **Diagnostics** icon in the title bar.

3. Click the **User Management** button to open the Runtime User Management pop-up display.

4. Swipe the RFID card across the reader. The RFID user account is now added to FactoryTalk Security.

Next we need to add the individual user account to an existing group that is part of the configured runtime security. Our application uses the following groups for runtime security:

- Operators
- Engineers
- Supervisor
5. Click the **Modify Group Membership** button to open the Modify Group Membership pop-up display.

![](Image)

6. Click **Select User/Group** and select the RFID user account you just added (users Admin, EN1, OP1, and SU1 were created offline). **Note:** your RFID user account will be unique.

![](Image)

7. Click **FactoryTalk Group** and select the **Operators** group.

![](Image)
8. Click **Add to Group**.

   The Result: text field should indicate that your RFID card user was added to the Operators group.

   ![Result](image1)

9. Click **Cancel** to close the pop-up display.

10. Click the **X** to close the Runtime User Management pop-up display

11. Click the unlock icon in the title bar to log SU1 out of the application.

12. Swipe the RFID card.

   The unlock icon should appear and the RFID user should display as the current logged in user

13. Click the unlock icon to logout.

   One of Ralph’s operators, lost his RFID card. Ralph has to delete the account from the application to prevent unauthorized access. Now let’s delete the RFID user account from the application.

   1. Click the lock icon and login again with the Supervisor account.

   2. Navigate to the Runtime User Management display by clicking the **Diagnostics** icon and then click the **User Management** button.

   ![Diagnostics](image2)

   3. Click the **Delete User/Group Account** button

   ![Delete User/Group Account](image3)
4. Click **Select User/Group**, select the RFID user, and then click **Select**.

![User or Group Selection](image)

5. Click **Delete** to delete the RFID user account from the runtime application.

The **Result**: text box should indicate the user was deleted.

![Delete User/Group Account](image)

6. Click **Cancel** to close the pop-up display.

7. Click the **X** to close the Runtime User Management pop-up display.

8. Click the unlock icon to logout of the application.

9. Swipe the RFID card again. Close any popup displays until the **Login** popup is visible. Notice the user can no longer log in.

![Login](image)
Ralph has been asked to reset the password for operator, OP1.

1. Click the lock icon and login again with the Supervisor account.

2. Navigate to the Runtime User Management display by clicking the Diagnostics icon and then click the User Management button.

3. Click the Change User Password button.

4. Click Select User, select OP1, and then click Select.
5. Click **New Password** and enter **pvp**.

6. Click **Confirm Password** and enter **pvp**.

7. Finally, click **Change Password**.

The **Result**: text box should indicate that the password was changed.

8. Click **Cancel** to close the pop-up display.

9. Click the **X** to close the Runtime User Management pop-up display.

10. Click the unlock icon to logout of the application.

11. Click the lock icon and login using the Operator account.

   - **User name**: op1
   - **Password**: op1

   Notice that the original Operator account has changed and that you are unable to login.

12. This time login using the following information:

   - **User name**: op1
   - **Password**: pvp

   You should now be successfully logged in as OP1.

Ralph has seen how easy he can manage user accounts during runtime. He no longer has to go back to the original hmi project to make his user account modifications. He no longer has to rebuild a new runtime file and interrupt production in order to deploy the new runtime file.

Ralph has also seen how easily users can log into the hmi application using RFID cards. His operators are much happier because they don’t have to memorize their passwords and they don’t have to type in any of their login information.

Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click **here**.
How To

This scenario introduced a new feature of FTView 8.0 called Runtime User Management. A new sub category called **User Management** was added to the **Objects** main category. This is where the new runtime user management objects have been added.

We’ll take a closer look at the objects we used in our demo next. Afterwards, please feel free to explore the other user management objects.

1. Turn to FactoryTalk View Studio on the PC and double click the **71 User Management** display to open it.
We used 4 new user management objects and images were added to the buttons instead of using text to describe their function. The 3 buttons not requiring any additional configuration are:

- Add User/Group
- Delete User/Group
- Modify Group Membership
- Change User’s Password

2. Using Object Explorer (right click on the display), expand **Group1** and double click **PasswordButton3**.
There is an additional configuration option called **Mode**. This option allows either just the current logged in user to change their own password or an Administrator (an account with Administrators group membership) to change any user password. The demo was configured to change any user password.

3. Close the **Password Button Properties** window.

4. Using Object Explorer, find **AddUserGroupButton1**.
5. Right click AddUserGroupButton1, and select Key Assignments...

6. Select 12 – F12 from the Select a key assignment: drop down list, and click OK.

7. Close the 71 User Management display and save your changes.

8. Open the 01 Main display by double clicking it.
9. Using Object Explorer, find **LoginButton1** under Group 3.

10. Right click **LoginButton1**, and select **Key Assignments...**

11. Select **11 – F11** from the **Select a key assignment**: drop down list, and click **OK**.
12. Close the **01 Main** display, and save the changes when prompted.

13. Open the **Titlebar** display under the **Global Objects** container

14. Using Object Explorer, find **LoginButton1** and double click it to open its properties.

15. On the General tab, uncheck **Visible** under the **Domain name** property. We aren’t using an Windows linked user accounts in this lab.

FactoryTalk View Machine Edition v8.0 introduced the option to specify a domain name as part of the Login dialog popup. This saves the user from having to type in the domain name in front of the user name.

16. Click **OK**. Close the **Titlebar** display and save the changes.
New User Management objects

- Add User/Group - use this button to add a FactoryTalk Security user, Windows-linked user, or Windows-linked group to the running application.
- Delete User/Group - use this button to delete a FactoryTalk Security user, Windows-linked user, or Windows-linked group from the running application.
- Modify Group Membership - use this button to add or remove a FactoryTalk Security user, Windows-linked user, or a Windows-linked group to or from a FactoryTalk Group.
- Unlock User - use this button to unlock a FactoryTalk user account that has been locked
- Enable User - use this button to enable a disabled FactoryTalk user account
- Disable User - use this button to disable a FactoryTalk user account

In addition, the Login button configuration has been changed to include the ability to make the domain name visible in the login window at runtime.

Tips:
- The DEFAULT user cannot use these new User Management buttons.
- Only FactoryTalk Security and Windows-linked users and groups can be managed using these buttons.
- Important: Users and Groups added at runtime will not have any security codes configured until they are added to pre-existing Groups that have been configured with access codes.
- Removing a Windows-linked user or group at runtime will not remove the user from the Active Directory. This action will only remove the user or group from the application.
- You can’t manage a Windows-linked account from the runtime such as change password, disable the account, etc. This is done within Active Directory.

- When adding a Windows-linked user or group to an application on a PanelView Plus 6 or PanelView Plus 7 terminal, user will be prompted to enter an authorized user name and password. The user will then have a 5 minute window during which Windows-linked users or groups can be successfully added. When 5 minutes has passed, the user will be asked to log in again.

- Any changes made to users and groups during runtime are contained within the runtime file. It is highly suggested that the runtime file be transferred and restored on a computer with FactoryTalk View Studio in order to be retained and maintained.

- It is recommended that access to these buttons be limited in the application to reduce unplanned modifications.

- Text on the above management windows will be included in string exports for Language Switching purposes.

This information is contained in AID 613707.

These new runtime management objects allow security –adding new users, deleting users, changing passwords, etc. - to be changed at the terminal, during runtime. You no longer have to go back to the HMI project file, make the changes there, create a new runtime file, and then redeploy the new runtime file.
How the RFID Card Reader Works

The RFID reader acts like a keyboard and passes its data to text entry fields. The Login and User Management popups in the application provide these text entry fields. The reader is configured to send Function Keys that are part of a custom string. The F11 key is assigned to the Login button in the Machine Edition application. The F12 key is assigned to the Add User button in the Machine Edition application – this button performs the FactoryTalk Security enrollment function.

RFIDeas is an Encompass partner and they offer RFID reader catalog numbers that are specific to Rockwell Automation. The following functions are performed by the Rockwell Automation reader: Single Factor Logon, Two-Factor Logon, and Enrollment (adding the RFID user to FactoryTalk Security during runtime).

All you have to do is assign the appropriate function keys in your application – F10, F11, or F12.

Every time the RFID card is swiped, the reader sends the following:

- F12
- F3
- <user id>
- Enter
- F4
- <password>
- Enter
- F5
- <password>
- Enter
- Enter
- Esc
- F11
- F2
- <user id>
- Enter
- F3
- <password>
- Enter
- Enter
- F10
- F2
- <user id>
- Enter
- F3

So, depending on which display has focus and which function key is assigned (F10, F11, or F12) will launch the appropriate text entry popups. See AID 677180 for part number and configuration information.
Module 2 – Increase Line Productivity - Managing Machine / Process Parameters with Recipe Manager

Business Issue
Each time the Super Juice Company approves a new flavored juice for production, the control engineer, Rita, spends excess time editing recipe files. Either within the HMI application or Controller ladder file, depending on who worked on the project before her. As a result, Rita is looking for an easier way to manage simple recipes.

Solution
Rita takes advantage of the Recipe ActiveX Control which uses a CSV (Comma Separated Values) file format to easily create a new production recipe using Microsoft® Excel. As a result, Rita is quickly able to edit an old recipe file to accommodate the new flavor.

Demo
You have been asked to create a recipe for a new juice flavor, Mango, and start production of it this afternoon.

1. Using Windows Explorer, browse to C:\Lab Files\Demo on the lab PC.
2. Click on the Orange.csv file and press Ctrl + C then press Ctrl + V to copy and paste it.
3. Select the copy of the Orange.csv file and rename it to Mango.
4. Double click the Mango.csv file to open it in Excel.
5. Change the following values to create the Mango juice recipe.
   - Column A, Row 1 = 50
   - Column A, Row 2 = 70
   - Column A, Row 10 = 10
   - Column B, Row 1 = Mango
6. Close and save the new Mango recipe. Select Yes if you receive a compatibility message.

You have now easily and quickly created a new Recipe file offline, without interrupting current production. Now let’s transfer the new recipe file from the lab PC to the PanelView Plus terminal.

7. Right click on the Windows Explorer icon in the lower left part of the system tray on the lab PC and select Windows Explorer to launch a new window.

8. In the address box, type the following: ftp://192.168.1.20

10. Select the Explorer window on the lab PC showing C:\Lab Files\Demo and click and drag the *Mango.csv* file to the *Formulations* folder of the PanelView Plus 7 terminal.

You have now successfully transferred the new recipe to the terminal remotely, without interrupting production.

You should now see the folder list of the PanelView Plus 7 terminal.

11. Close both Windows Explorer windows.

12. Turn to the PanelView Plus 7 terminal and from the *Plant Summary* display, click the *Login* icon in the title bar. Login with the operator account.
   - User name: **op1**
   - Password: **op1**

   *Note*: If you performed the Runtime User Management section earlier use **pvp** for the password.
The unlock icon will appear and user OP1 will display as the current logged in user.

13. Click on **Tank A3** to navigate to the **Tank A3 Detail** display.

14. Click the **Change Formulation** icon.

15. Select the **Mango** recipe from the list by using the **Up** and **Down** arrow keys and the **Enter** key.
16. Click the Recipe Load icon to download the recipe to the controller.

You should see Loading succeeded indicating a successful download to the controller.

17. Close the Formulation Manager on top display by clicking the X.

Notice that Tank A3 is now indicating the Mango flavor is being produced.

By using the RecipePlus ActiveX, Rita has quickly and easily created the new Mango recipe without interrupting current production. Additionally, by taking advantage of the File Transfer Protocol server on the PanelView Plus 7 terminal, Rita has easily transferred the new recipe file to the terminal out on the plant floor. Again without interrupting production.

Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click here.
How to

Use FactoryTalk View Studio on the lab PC and the SuperJuicePartial HMI application when performing the How To section.

The demo uses RecipeNumber, FolderName, LoadEn, Float001 – Float010, String001, RecipeName001 - RecipeName011, and Status.

RecipeNumber is an analog HMI tag that corresponds to the number associated with the recipe file. You can have up to 255 recipes.

FolderName is a string HMI tag that specifies where the recipe files are located – they are located on the terminal at \My Documents\Formulations.

LoadEn is a digital HMI tag and a transition from 0 to 1 will load the recipe values from the selected recipe file into the tags specified by Float001 – Float010 and String001.

Float001 - Float010 are assigned to controller tags that correspond to the set points in the recipe file.

String001 is the name of the juice flavor for that specific recipe.

RecipeName001 – RecipeName011 are HMI string tags that contain the names of the recipe files – Apple, Orange, Lemon, etc.

Status is an analog HMI tag that indicates the current state of the ActiveX control.

A single recipe file can contain up to 512 numeric values and 100 string values.

Let's assign the Recipe folder path. This is where the recipe csv files reside.

1. Open the HMI tag database by double clicking Tags and then double click the Recipe folder.
2. Find the RecipeFolderName tag. Enter the Initial Value as shown, check the Retentive checkbox, and click Accept to apply the changes.

3. Close the HMI tag database.

We currently have 10 recipe files. We want to create an additional recipe for the new juice flavor, Mango. We will assign the new recipe file name to the Recipe ActiveX control. But first we will assign the recipe folder name tag we just modified to the ActiveX Control.

4. Open the 10 Tank_Detail display by double clicking it.
5. Using the **Object Explorer**, find **MERecipe2Enhanced3** under **Group47** and double click it to bring up its properties.

6. Click on the **Connections** tab to view the tags associated with the ActiveX control.
7. Assign HMI tag, `Recipe\FolderName`, to `FolderName` by using the Tag Browser.

Since we now have 11 recipes, we need to assign another HMI tag to the RecipeName section of the ActiveX control.

8. Scroll down to `RecipeName011` and assign HMI tag, `Recipe\RecipeName11` by using the Tag Browser.
9. Click **OK** to save the changes and close the **ME Recipe 2 Enhanced Properties** window.

We will now create an 11th state in the Piloted List Selector and assign the same HMI tag we just assigned to the ActiveX control for its caption as an embedded string variable.

10. Open the **60 Tank Recipe** display by double clicking it.
11. Using the **Object Explorer**, find **PilotedListSelector1** and double click it to bring up its properties.

![Object Explorer](image1)

12. Click the **States** tab.

![Piloted List Selector Properties](image2)

When the state changes based on using the arrow keys and the enter key, the state value is passed into `Recipe\RecipeNumber` (assigned to `RecipeNumber` of the control). This number corresponds to the 11 recipe files. Each state's caption uses an embedded string variable associated to `Recipe\RecipeName1` – `Recipe\RecipeName11` (assigned to `RecipeName001` – `RecipeName011` of the control). These are the names of the recipe files.
13. Select State9 and then click Insert State to create State 10 since we now have 11 recipes because of the new Mango juice flavor.

14. Select State10 and change the Caption color to black. Click Insert Variable, and then click String. This variable is used to display the recipe name in the selector list.

15. Click the tag browser button and select RecipeName11.
16. Click **OK** twice to accept the tag and click **Apply** to save the **Caption** changes.  

Next, let’s assign a HMI tag to **Value** which provides the state value (0 – 10) for the Piloted List Selector.

17. Click the **Connections** tab and assign the tag, **Recipe\RecipeNumber**, to **Value** using the **Tag Browser**.

![Tag Browser](image)

18. Click **OK** twice to accept the tag update and close the **Piloted List Selector Properties** window.  

The Recipe Selector display contains a multistate indicator to show the recipe action status. Let’s explore its configuration.

![Multistate Indicator](image)

19. Using the **Object Explorer**, find **MultistateIndicator1** and double click it to bring up its properties.

![Object Explorer](image)
20. Click the **Connections** and **States** tabs to explore the properties.

![Multistate Indicator Properties](image)

The ActiveX control provides its state info to the control’s Status property. The state info it provides is a unique analog value. The Status property is assigned to RecipeStatus_Tag. Each state displays the unique caption corresponding to the status of the control.

The final object pertaining to recipes is a Load enable button. Pressing this button updates the corresponding controller tags with the selected recipe values.

21. Close the **Multistate Indicator Properties** window.

22. Close the **60 Tank Recipe** and **10 Tank_Detail** displays. Select **Yes** if prompted to save changes.

---

**Configuring and Using the FTP Server on the PanelView Plus 7 Terminal**

We also used the FTP server feature of the PanelView Plus 7 terminal to transfer the new recipe file to the terminal remotely. The FTP server is pre-installed on the terminal and can be enabled/disabled via a Control Panel applet.

![FTP Server](image)
There is also a configuration applet located in the Control Panel -.

The **Default Directory** was changed from **Temp** to \\ which exposes all of the folders.

The FTP server was configured to allow anonymous access. It could also be configured to use security - **Use Authentication** would be checked, **Allow Anonymous Logins**, **Allow Anonymous Uploads**, and **Allow Anonymous VRoots** would be unchecked. The **User List** property would then contain the user account that would be created using another Control applet -.

This scenario demonstrated how easily a simple recipe file can be created and maintained by using the RecipePlus ActiveX and Microsoft Excel. It also showed how the recipe file can be transferred to the PanelView Plus 7 terminal remotely using the FTP server functionality with interrupting current production.
Module 3 – Reduce Travel Cost - Monitor Application Remotely with ViewPoint

Business Issue
The maintenance engineer, Bill, at the Super Juice Company is looking for a way to monitor numerous plants without interrupting production and reduce travel costs.

Solution
Bill takes advantage of FactoryTalk ViewPoint, a thin client connection via a Microsoft supported web browser, to remotely connect to the PanelView™ Plus 7 terminal. Bill is now able to monitor the plants from his office or home and has eliminated the need for unnecessary travel. Since ViewPoint publishes its own displays, independent of what the operator sees, Bill is able to navigate the specific application without affecting production.

Demo
1. Launch Internet Explorer on the lab PC and enter the following address: http://192.168.1.20 (this is the IP address of the PanelView™ Plus 7 terminal).
2. Log into the application.
   - Enter op1 for the user name.
   - Enter op1 for the password.
   - Click the Log On button.

Note: If you performed the Runtime User Management section earlier, use pvp for the password.
It may take up to 1 minute for the display to initially load. Each tank’s fill color may be different than is shown above, depending on what recipe was last loaded for that tank.

You can resize the browser if needed and ViewPoint will scale the display at the same time.

3. Click on any of the tanks to navigate to the tank’s detail display.

Notice that the application running on the PanelView Plus 7 terminal is not affected by the Viewpoint navigation.

4. Click on the page up button to return to the Plant Summary display.
5. Click the **Valve** above **Tank A1** to view its status.

Notice that the operator does not have access to that display.

6. Click **OK** and then click **Log off** in the upper right corner.
7. Log into the application again.
   - Enter en1 for the user name.
   - Enter en1 for the password.
   - Click the Log On button.

   ![Log on screen](image1)

   It may take up to 1 minute for the display to load.

8. Click the Valve above Tank A1 to view its status.
You should now see the valve status pop-up display for Tank A1.

![2-State Device](image)


Bill was able to use FactoryTalk ViewPoint to access the PanelView Plus 7 terminal remotely and not disrupt production or interrupt the operator. The reason for this is that Viewpoint publishes its own independent copy of the display.

Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click [here](#).
How To

Configuration of FactoryTalk® ViewPoint is done through the FactoryTalk® ViewPoint Administration tool, launched from FactoryTalk® View Studio. Here, the desired displays are selected and published so that they will be available to any browser client connecting to your operator interface terminal.

The FactoryTalk® ViewPoint ME Administration tool runs on the same computer as FactoryTalk® View Studio and is available from the Free Software Download website.

The ViewPoint ME server that runs on PanelView™ Plus 7 terminal is already installed and can be disabled/enabled via the Control Panel applet.

1. Select **ViewPoint Administration** from the Application menu to launch the tool.
2. Scroll down to and select **20 2-State Device**. Then click **Publish displays**.

Displays that are selected and published are the ones we will have access to when we connect to the ViewPoint Server using a web browser.
Configuring FactoryTalk® ViewPoint ME security

FactoryTalk ViewPoint has the ability to secure individual display access as well as secure the write capability for that display. You can also secure the entire application.

1. Select **Security Settings** on the red navigation bar in the FactoryTalk® ViewPoint Administration tool window.

   Note that in ViewPoint 2.0 security is role based rather than user based. As a result only User Groups are shown and not individual users. You can expand on the groups that have a + sign beside them to see the list of users assigned to each group but you cannot individually select the user.

2. Select the **Secured Displays** tab and check **Enable Application Security**.

   Once **Enable Application Security** is checked, security is applied to each published display.
3. Select **1001 FTVP MAIN** and assign its security settings as shown below. Click the box twice for a green check mark.

![Application settings for 1001 FTVP MAIN](image)

4. Select **1010 Tank_Detail** and assign its security settings as shown below.

![Application settings for 1010 Tank_Detail](image)

**Engineers** are given write and view privileges. **Operators** are given only view privileges.
5. Finally, select **20 2-State Device** and assign its security settings as shown below.

![Security Settings](image)

**Engineers** are given write and view privileges. **Operators** are denied access.

6. Click **Save** to apply the security settings.

7. Close the FactoryTalk® ViewPoint Administration Tool window.

This scenario demonstrated how a PanelView Plus 7 terminal can be accessed remotely without disrupting production or interfering with the local operator. Furthermore, security can be applied to the published displays to limit access to the display itself or provide view access only.

---

**Module 4 – Reduce Travel Cost & RemoteTroubleshooting Capability - Remote Display Access with VNC**

**Business Issue**

Laura, Production Supervisor, is looking for a better and faster way to understand why production is down at a plant in a different location and to provide assistance to the operator, Mark.

**Solution**

The application uses the TerminalInfo ActiveX control in order to obtain the IP Address of the terminal without the need to shutdown the application. Once the terminal’s IP Address has been obtained, it is provided to Laura. Laura connects to the
company’s VPN and then to the terminal through VNC (Virtual Network Computing) using a view only password. She is now able to view a live feed of the terminal’s display and is able to provide immediate assistance.

Demo

1. On the PanelView Plus 7 terminal, on the Plant Summary display, click the Login icon in the title bar. Login using the Engineer account.
   
   User name: en1
   
   Password: en1

   The unlock icon will appear and user EN1 will display as the current logged in user.

2. Click the Diagnostics icon in the title bar. Record the IP Address found in Network Information to be used for the VNC connection.

<table>
<thead>
<tr>
<th>Network Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP Address</td>
</tr>
<tr>
<td>Subnet Mask</td>
</tr>
<tr>
<td>Gateway Address</td>
</tr>
<tr>
<td>MAC Id</td>
</tr>
</tbody>
</table>

3. As Laura, go to the desktop of the lab PC and click Start>TightVNC Viewer.
4. Enter the IP address that was obtained in step 2 and press **Connect**.

5. Enter **pass2** for the password and click **OK**.

Laura is now connected to Mark's terminal.
6. As Laura, using the VNC connection, try clicking on the icons across the top of the application. Nothing should happen as Laura only has view control.

7. As Mark, navigate the application from the PanelView™ Plus 7 terminal – click the Super Juice logo to navigate to the Plant Summary display.

   Laura is now viewing a live feed of the application on her PC. She is seeing exactly what Mark is doing and can assist him.

8. Exit the VNC connection on the PC by clicking the X to close the window.

VNC allows one to view or control the entire PanelView Plus 7 terminal unlike FactoryTalk ViewPoint, which publishes independent web pages. This tool is ideal for troubleshooting when the expert is in a different location or the terminal is in a remote location. Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click here.
How To

This scenario uses the TerminalInfo ActiveX control and VNC to allow remote access to a PanelView™ Plus 7 terminal. In this scenario, the TerminalInfo ActiveX control provided the terminal’s IP address without having to shut down the running application.

Let’s explore the TerminalInfo ActiveX control configuration.

Terminal Info ActiveX

The Terminal Info ActiveX control was used to provide the terminal’s IP address without needing to shut down the application.

1. Open the **100 Startup Pop Up** display by double clicking it.

2. Double click **METerminalInfoControl1** to bring up its properties.
3. Click the **Connections** tab to view the tags associated with the ActiveX control.

   ![ME TerminalInfo Control Properties](image)

   This ActiveX control can also obtain the IP info of a second NIC – the 2711P-RN20 ethernet PCI card accessory would be a second NIC. This Ethernet card accessory provides an isolated NIC which can be used for remote connectivity to a PanelView Plus 6 terminal, while using the internal NIC for the Control network. The PanelView Plus 7 terminal does not support any add-on PCI cards.

   The TerminalInfo ActiveX control also provides some diagnostic information, if tags are assigned, such as CPU Temperature, Battery Voltage, Memory Load, etc.

   Once **TerminalInfoEnable** transitions from 0 to a 1, any assigned connections are updated every 500mS. The Device Name and NIC information is only updated once per trigger.

4. Close the **ME TerminalInfo Control Properties** window and the **100 Startup Pop Up** display.
VNC – Virtual Network Computing

The PanelView™ Plus 7 terminal comes with a VNC server installed. The terminal ships with the VNC server disabled by default. The VNC server can be enabled through a Control Panel applet.

The VNC server configuration is done using a Control Panel applet. The default setting View Only (no remote control) was unchecked and Enable security was checked. Passwords for the Password and View-only password properties were created by typing the password in the text box for each selection.

If write control is desired, you would connect to the PanelView Plus 7 using the assigned password for Password property. If Enable security & View Only (no remote control) is unchecked, no password is needed when connecting to the terminal and full control is granted. Checking View Only (no remote control) overrides any write control privileges.
Module 5 – Increase OEE - Log Production Data with DataStore Plus

Business Issue
The Plant Manager, Marcus, is looking for ways to improve production yields.

Solution
Marcus uses the Data Store Plus ActiveX to generate new data log files daily in a CSV (Comma Separated Values) file format. This allows Marcus to easily trend and generate yield reports using Microsoft® Excel. As a result, Marcus has eliminated inefficiencies within the production line and improved production yields.

Demo

1. Click on the Windows Explorer icon in the taskbar at the bottom of the screen of the lab PC.

2. Browse to C:\DataLog. The DataStore Plus ActiveX has been configured to create and log to the csv file in a remote location instead of on the terminal.

3. Select the csv file that is currently being logged to and press Ctrl + C then press Ctrl + V to copy and paste it. You can tell which file is being logged to by looking at the size attribute and see that it is increasing in value.

   You now have a copy you can open and work with in Excel and the data can still continue to log to the original csv file.

4. Open the copy of the CSV file you just created and examine its contents.


   Using the DataStorePlus ActiveX Control, Marcus was able to create csv log files that can be opened in Microsoft Excel®. Various charts or graphs can be created to present the data for meaningfully. Also, by logging to a remote PC, Marcus has obtained more storage capability and more direct access to the log files. He does not need to physically access the terminal in order to obtain the log files.

   Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click here.
How To

A shared folder on the remote PC has already been created, called DataLog using the procedure below. Note: There is no need to perform the following steps until the “Setting up the DataStore ActiveX Control” section.

The local account, Labuser, was given full access permission to the DataLog shared folder.

Now we need to map from the PanelView Plus 7 to the DataLog folder on the PC. A command prompt window was opened on the PanelView Plus 7 and the following net use command was entered to create the network mapping.

```
net use DataLog \WIN7-VM\DataLog /user:labuser
```

The net use command is used to connect to the shared resource, the DataLog folder in our case. The command consists of the following:

- A name for the network share - DataLog was used but another name could have been used.
- The location of the desired shared resource – the network path
- A user name of an account that has access to the shared resource – labuser in this case. This is optional.
We have successfully mapped to the DataLog shared resource and can now see our mapping in the Network folder on the PanelView Plus 7 terminal.

### Setting up the DataStore ActiveX Control

Now that we have seen how to setup the mapping, let’s configure a HMI tag that lists the location to log the csv file to and that we will assign to the ActiveX a bit later on.

1. Double click Tags to open the HMI Tag Database.

2. Open the DataStore folder and select the DataStore\File_Location string tag.

3. Perform the following steps:
   - Enter `Network\DataLog\SuperJuice.csv` for the Initial Value: this is the mapped folder name located in the Network folder on the PanelView Plus 7 terminal along with the desired name of the csv file that will be created.
   - Check Retentive – we will not be changing this location during runtime.
   - Click Accept to save the changes.

4. Close the HMI Tag database.

Next, let’s configure the ActiveX control.
1. Open the **100 Startup Pop Up** display by double clicking it.

2. Double click **MEDDataStorePlus2** to bring up its properties.

3. Click the **General** tab and assign the file management settings as shown below.

The control is now setup to start a new log file every hour and to only maintain 3 log files total.
4. Click the **Advanced** tab and assign the logging settings as shown below.

5. Click the **Connections** tab and assign HMI tag, `DataStore\File_Location`, to `FileLocation` by using the Tag Browser.

6. Assign HMI tag, `DataStore\Tank1Temp`, to `Float01` by using the Tag Browser.
The HMI tag actually points to a direct reference tag, which could have been used instead. An HMI tag was used just to make it easier to read and to view in the csv file since we selected to include the tag name in the log file.

7. Scroll down to String01 and assign the HMI string tag `DataStore\Tank1Flavor` using the Tag Browser.

8. Select OK to apply the changes.

The Trigger connection uses a digital HMI tag, `DataStore\Trigger`, to enable and disable the data logging.

This same digital HMI tag is also tied to the Datalog enable/disable selector switch on the 70 Maintenance display.

9. Close the 100 Startup Pop Up display and select Yes to save changes.
The DataStorePlus ActiveX control allows one to configure which analog tags and string tags to log to a CSV file. It also allows the configuration of the frequency of logging, the format of the csv file, and the creation of additional log files. The following table describes the difference between the internal Data Log Model and the DataStore Plus ActiveX.

<table>
<thead>
<tr>
<th>Internal Data Log Model</th>
<th>DataStore Plus ActiveX control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native/built-in control</td>
<td>Add-on feature</td>
</tr>
<tr>
<td>Timed, data change, data % change triggers</td>
<td>Timed or tag trigger logging</td>
</tr>
<tr>
<td>Always active/running</td>
<td>Can control logging (on/off)</td>
</tr>
<tr>
<td>Only 1 data log model supported at runtime</td>
<td>Multiple data log support at runtime</td>
</tr>
<tr>
<td>1 file only, first in-first out after maximum data points</td>
<td>Multiple file support</td>
</tr>
<tr>
<td>300,000 data point maximum (pre v7)</td>
<td>Only storage limit to data points</td>
</tr>
<tr>
<td>1,000,000 data point maximum (v7 or higher)</td>
<td></td>
</tr>
<tr>
<td>Binary proprietary file</td>
<td>Plain text .CSV file</td>
</tr>
<tr>
<td>Works with Trend display to show historical data</td>
<td>Does not work with trends</td>
</tr>
<tr>
<td>Supported in all PanelView Plus 7 terminals</td>
<td>Supported in all PanelView Plus 7 terminals</td>
</tr>
<tr>
<td>Good for Trending historical data and native functionality. Easy setup.</td>
<td>Excellent for plain text or high speed data archiving.</td>
</tr>
<tr>
<td>100 tags maximum</td>
<td>100 Analog tags and 50 String tags maximum</td>
</tr>
</tbody>
</table>

Refer to **AID 520349** for more information regarding the DataStorePlus ActiveX.
Module 6 – Reduce Maintenance Cost - Switch Application Language to Operator’s Native Language

Business Issue
Because the Super Juice Company is shipping new machines to its new production facilities in Europe and Asia, the control engineer, Lisa, has to create and manage multiple HMI application files which are in the native language specific to the operators so they can operate the equipment. Managing multiple files is challenging and time consuming.

Solution
Lisa takes advantage of the FactoryTalk View Machine Edition language switching capabilities which allows her to manage only one HMI application file instead of several - one for each unique language. With the push of a button, the operator can simply change the application language to his or her native language.

Demo
1. From the Plant Summary screen, click the Globe icon in the title bar to bring up the language selection display.

![Language Selection Display]

2. Click the Chinese flag and notice that most of the text on the display has changed.

3. Click the Mexican flag and notice how quickly the languages change.

4. Click the US flag to switch the language back to English.

5. Click the X to close the language selection display.

Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click here.

How To
This scenario uses Language Switch buttons to quickly switch between different languages. Let’s take a closer look at how languages are supported during runtime. We will walk through the steps of how Spanish language support was added to the
application.

1. Click **Tools** from the menu in FTViewME and then click **Languages**.

   ![Tools Menu](image1)

   Notice a check mark next to English (United States). This check mark indicates which language is the default language for the application — the language the runtime application will use at startup.

2. Click **Add** and scroll down the list of languages till you find Spanish.

   ![Add Language](image2)

   Notice there are several Spanish options. This is to accommodate words that have a different meaning in certain countries.

3. Select **Spanish** (Mexico) and click **OK**.

4. Click **Apply**.

   Once the languages have been added to the application, the strings will be exported to an Excel file.
5. Click the **Export** button.

![Language Configuration window]

6. Select **Export strings for all languages to an Excel spreadsheet** and ensure both **Optimize duplicate strings** and **Open exported file** are checked.

7. Click **Next**.

![String Import Export Wizard - Export Operation window]
8. Click **Finish**.

![Image](image.png)

Note the default location for exported language files is the **C:\Users\Public\Public Documents\RSView Enterprise\Strings** folder. You will use the default location for this lab.

A progress bar may appear along with a message stating that the export will take some time. Note that there is no dialog box to prompt when the export has completed. For this lab the export should take about one minute and will generate the Excel spreadsheet when complete.

9. Open up the Excel spreadsheet by clicking on the **Excel** icon in the bottom of the taskbar if it doesn’t open automatically.

Notice the columns in Excel – each language has its own special identifier (**en-US**, **es-MX**, and **zh-CN**) which is used by the language translation utility and the language switch buttons.

<table>
<thead>
<tr>
<th>F</th>
<th>Formula Bar</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>en-US</strong></td>
<td><strong>REF</strong></td>
<td><strong>es-MX</strong></td>
<td><strong>REF</strong></td>
<td><strong>zh-CN</strong></td>
</tr>
<tr>
<td>&quot;<strong>UNDEFINED</strong>&quot;</td>
<td>&quot;<strong>UNDEFINED</strong>&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

All the strings that need to be translated are indicated by "**UNDEFINED**".

10. After you have finished examining the file, close Microsoft Excel and click **No** if prompted to save any changes.

Previously one would have to perform the language translation manually. The FactoryTalk® View Translation Utility now provides a way to automate the translation process. The utility uses internet resources to provide a ‘gist’ translation of the exported strings. A ‘gist’ translation is a rough translation that does not generally follow grammatical rules or synonym selection.

Since we do not have internet access in the lab, the following are screen shots that show how one would use the FactoryTalk® View Translation Utility.

You would browse for the exported language file that you want to translate.

The 'gist' translation may not provide the same meaning for the string in your native language. The translation utility provides the option of using a custom dictionary. The custom dictionary is also an Excel XLS file that uses special column headings. See AID 481190 for more information.

<table>
<thead>
<tr>
<th>Custom User Dictionary Template</th>
<th>Keyword</th>
<th>Localized Strings</th>
</tr>
</thead>
</table>

By checking the box indicated below, the utility will search the custom dictionary first for the string to be translated. If it finds the string in the custom dictionary, it will use that translation. If it doesn’t find the string it will use the internet to find the translation.

Next, you would select your Target languages from the list and click the Translate button. When the translation completes, the updated Excel file can now be imported back into the application.
11. Import the Excel file containing the translations into the application following the steps below.

12. Select the SuperJuicePartial_3.xls file, click open, then click Finish.

13. Click OK to close the Language Configuration window once the import has completed. Ignore any errors that may have occurred.
Now that we have translated the strings for our application, we need to be able to select between the different languages. FactoryTalk View Studio provides this ability through the use of a special button called Language Switch Button. Let's add a Spanish language switch button to the 30 Language Selection display.

14. Open the 30 Language Selection display by double clicking it.

15. Select Objects>Advanced>Language Switch Button.

16. Draw a rectangle in between the US and Chinese flags by holding down the left mouse button and dragging the mouse.
17. Make the changes shown below on the General tab.

18. Click the **Label** tab and assign the Mexican flag to the **Image:** property by using the browse button. Check **Image scaled.** This will scale the flag to the size of the button.
19. Select the **Common** tab. Change the **Size** and **Position** attributes as shown below

![Language Switch Button Properties](image)

20. Click **OK** to close the **Language Switch Button Properties** window and apply the changes. The display should now look like this

![Language Selection Display](image)

21. Close the **30 LanguageSelection** display and select **Yes** to save the changes.

---

FactoryTalk® View Machine Edition supports multilingual capability at design time as well as run-time language switching between a maximum of 20 different languages. To facilitate localization, an HMI designer exports all of an application’s strings to a spreadsheet (*.XLS or *.XLSX) file. The translations are done in the spreadsheet, either manually or using a utility, and it is then imported back into the HMI application.
Module 7 – Reduce Development Time - Reuse Common HMI Components with Global Objects

Business Issue

There are four identical tanks in the Super Juice Company production plant and each one is represented on its own display. The control engineer, Ray, has to individually edit each display throughout his development project when tank updates are required. This repetitiveness consumes too much time – preventing Ray from working on other projects.

Solution

Ray takes advantage of Global objects to consolidate four HMI screens into one HMI screen. However, each tank maintains its unique set of controller tags by the use of parameters. As a result, now when updates need to be made to the tanks, Ray is able to preserve time because he only has to make the update in his project once in one location.

Demo

1. From the Plant Summary screen, click on any one of the four tanks.

2. Click the page up button or the Super Juice logo to navigate back to the Plant Summary screen.

3. Click on a different tank.

Notice that the tank number and information for that specific tank changes according to which tank was selected from the Plant Summary screen. Only one tank display exists in the application. The use of global objects and parameters makes this possible.

Please refer to the following How To section to see how this demo scenario was created. If you would like to perform the next demo scenario please click here.
How To

This scenario demonstrated the use of Global objects. If the same object is used repeatedly, like the tank in our demo, why not create it once rather than multiple times. If the object needs to be updated, you only need to make changes in one place, the Global Object display that contains the object. Let’s explore how global objects were created and configured for the demo.

All global objects are created by first creating a display under the Global Objects container in FactoryTalk View Studio. In our demo we have 3 global object displays.

1. Double click the **Tank** global object display to open it.

These objects were either pulled in from a graphic library or created using drawing tools within Studio. Let’s take a look at the large tank graphic.
2. Right click the large tank and then select Object Explorer
Notice that several objects are indicated as being inside the selection area – this is shown by the Object Explorer as being Group.

3. Right click Group 10 and select Global Object Parameter Definitions. This allows us to assign parameters to the global object. Parameters allow us to use a single object in multiple places and yet display unique information.

4. Enter #1 for item 5 and enter Tank Number for the Description. Click OK.

Notice the other parameters and their descriptions.
5. Expand **Group 10** and double click **Text1**.

Notice the parameter #1 is used in the direct reference tag. This is the place holder for our unique tank number. We will see how we assign the actual tank number in the upcoming steps.

6. Click **Cancel** and double click **GotoDisplayButton1**.
Notice the parameters #1, #2, #3, and #4 in the Parameter List. This is called parameter passing because the parameters are passed onto the display that the goto display button is referencing. We use parameter passing because the Goto Display button is part of the Global Object.

If parameters are not being passed to the referenced display, we would specify actual tag values in the parameter list.

7. Select the Connections tab.

The parameter #5 is assigned to the Display Name property. Now let’s see how the actual values get assigned to their respective parameters.

8. Close the Tank global object display and save the changes.

9. Double click the 01 MAIN display to open it.
10. Move the mouse to the middle of the left most tank and right click. Select *Global Object Parameter Values*.

This is how the parameters defined on the global object display get assigned to actual values or tags.

11. Assign HMI tag `DisplayNav\Navigate_To_Tank_Detail_PVP` to parameter #5.
12. Enter 0 to parameter #1.

13. Click **OK** to accept the assignments.
Let's examine the parameter #5 more closely and its tag assignment to better understand how Global Objects and Parameters work.

Parameter #5 was assigned to the Display Name property for the goto display button of our tank global object. We then assigned the actual tag to parameter #5 on the MAIN display where we have placed 4 tanks – all of them being the same tank Global Object. The tag we assigned is a HMI tag called `Display\Navigate_To_Tank_Detail_PVP`.

If we take a look at this HMI tag again, we see that it is a Memory tag and has the Initial Value `10 Tank_Detail`.

This means that when any of the 4 tanks are clicked, the `10 Tank_Detail` display will open. Then the information being presented on this display will be specific to the tank selected from the MAIN display based on the value assignments for parameters #1, #2, #3, and #4.
Module 8 – Increase Line Productivity - Access Reference Material from Terminal with PDF Viewer

Business Issue
At Super Juice Company, downtime is excessive because many of the printed manuals for setup & troubleshooting are disorganized or difficult to locate. Therefore, the production manager mandated that all reference materials be stored electronically in a central location and be accessible from each PanelView Plus 7 terminal.

Solution
The control engineer, Chris, stored the latest PDF Manuals in a network folder accessible from each PanelView™ Plus 7 terminal. Chris then took advantage of the PDF reader on the PanelView Plus 7 terminal to view the pdf files directly on terminal. Chris also used the CaseStatement ActiveX control to easily select the desired manual. As a result, the production manager noticed a decrease in downtime.

Demo

1. From the Plant Summary screen, click the PDF icon at the top of the PanelView™ Plus 7 terminal to open the pdf selection pop-up display.

2. Select the PanelView Plus 7 User Manual using the Arrow keys and the Enter key.

3. Click the load icon to launch the PDF viewer.

   You may notice a progress bar as the PDF loads.

   Notice that the pdf opened to a specific page in the user manual – it is the section of the user manual that describes the Foxit PDF reader that we are using.

4. Navigate through the pdf to explore the features of Foxit Reader.

5. Close the pdf reader.

6. Select and explore the other two documents by repeating steps 2 - 5.

Operators can be presented with valuable information by using the Foxit pdf reader. Also, since the PanelView Plus 7 has limited internal storage, the pdf files can be located off of the terminal. This also makes it easier to manage the files.
How To
This scenario showed how operators can be presented with valuable information to help configure a process or to troubleshoot the system. This is possible because every PanelView Plus 7 terminal comes with Foxit PDF reader installed. Let’s take a look at how the demo was configured.

1. Double click the **11 PDF Select** display to open it.

2. Double click the Control List Selector to open its properties.

Notice that there are 3 states specified and that **Write on enter** is not checked.

We only specified 3 pdf files in the demo. If we specified more, we would change the **Number of states** to match. The **Write on enter** is unchecked because we are using the CaseStatement ActiveX to specify the specific PDF file to view. The “Enter” key is being used to trigger the CaseStatement ActiveX.
3. Select the **States** tab.

Here we have the 3 states listed. Each state has a value assigned – 1 through 3. This value is passed to the tag assigned on the Connections tab. The Caption field is the text we entered to describe each pdf file and is what is shown in the selector list during runtime.

4. Select the **Connections** tab and assign HMI tag **PDF_Viewer\PDF_Selection** to the **Value** property.
5. Click **OK** to apply the tag assignment. This will be the tag that receives the values 1 through 3 depending on which state is selected.

6. Double click the **MECaseStatementControl1** ActiveX control to open its properties.

7. Select the **Connections** tab and assign the following tags and literals per the table:

<table>
<thead>
<tr>
<th>Source</th>
<th>PDF_Viewer\PDF_Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case01_Test</td>
<td>1</td>
</tr>
<tr>
<td>Case01_Operator</td>
<td>“EQU”</td>
</tr>
<tr>
<td>Case01_Result</td>
<td>PDF_Viewer\PDF_One</td>
</tr>
</tbody>
</table>

The PDF_Viewer is a folder in the HMI Tag Database.
The assignments should appear as shown below.

![Image of Case Statement Control Properties window]

8. Click **OK** to apply the literal and tag assignments.

The Case Statement ActiveX was used to pass the specific path and file name for the pdf file to view. The **Source** property contains values 1, 2, or 3 depending on which name is selected from the Control List Selector. When the **Trigger** property changes from 0 to 1 (this is done by pressing the momentary button on the Control List Selector), the **Source** is evaluated against any assigned cases – in our demo there are 3 assigned cases. We are testing using the **EQU** operator. So, if **Source** contains a 1, then Case01 evaluates true and the **Case01_Result** is passed to the **Destination** tag.

9. Close the **11 PDF Select** display and save the changes.

Let's take a look at HMI tag **PDFViewerPDF_One**.

10. Double click **Tags** to open the HMI Tag Database.

11. Select the **PDFViewerPDF_One** tag.
12. Enter the following for *Initial Value* and check *Retentive*.

\Network\Manuals\2711p-um008\en-p.pdf – p 114

13. Click *Accept* to save the changes and then *Close* the HMI tag database.
Network refers to a folder on the PanelView Plus 7 that contains mapped folders. The mapped folder is called Manuals and contains the pdf files. The 2711p-um008_en-p.pdf is the PanelView Plus 7 Performance user manual and the -p 114 tells Foxit to open the pdf to page 114. There are several other switches that can be used with Foxit and starting on page 114 of the user manual contains more information.

We set up a shared folder on the lab PC. A folder called Manuals was created on the lab PC and it was shared.

![Manuals Properties]

On the PanelView Plus 7 terminal, we mapped from the PanelView Plus 7 to the Manuals folder on the lab PC. A command prompt window was opened on the PanelView Plus 7 and the following net use command was entered to create the network mapping.

```
net use Manuals \WIN7-VM\Manuals /user:labuser
```

The net use command is used to connect to the shared resource, the Manuals mapped folder in our case. The command consists of the following:

- A name for the network share - Manuals was used but another name could have been used.
- The location of the desired shared resource – the network path
- A user name of an account that has access to the shared resource – labuser in this case. This is optional.
We have successfully mapped to the Manuals shared resource and can now see our mapping in the Network folder on the PanelView Plus 7 terminal.

Here we can see the pdf files because of the mapping.

Here are the pdf files on the lab PC:

In order to launch the Foxit pdf viewer, another ActiveX control was used called Program Launcher. Let's see how this was configured.

14. Double click **100 Startup Pop Up** display to open it.
15. Double click **PGMLauncher** to open its properties – double click the gray area instead of the text.

16. Select the **Connections** tab. 

**ProgramLocation** is the location information of the program we want to launch.
**ProgramParameter** is the location and the file name of the pdf file we want to open and view. This specific information comes from the CaseStatement ActiveX control.

<table>
<thead>
<tr>
<th>Case</th>
<th>Test</th>
<th>Operator</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case01</td>
<td>1</td>
<td>&quot;ECU&quot;</td>
<td></td>
</tr>
<tr>
<td>Case01</td>
<td>2</td>
<td>&quot;ECU&quot;</td>
<td></td>
</tr>
<tr>
<td>Case02</td>
<td>3</td>
<td>&quot;ECU&quot;</td>
<td></td>
</tr>
<tr>
<td>Case03</td>
<td>4</td>
<td>&quot;ECU&quot;</td>
<td></td>
</tr>
</tbody>
</table>

**LaunchEnable** causes the specified program, FoxitReader.exe, to launch. This is triggered by the momentary button on the 11 PDF Select display.

17. Close the **ME Program Launcher Properties** window and the **100 Startup Pop Up** display.

In summary, this scenario demonstrated how a pdf reader can provide valuable information to the operator. The demo showed how the CaseStatement ActiveX control can be used to specify the location and file name for a pdf file. It also showed how the Foxit pdf reader can be launched from within FactoryTalk View Machine Edition by using the ProgramLauncher ActiveX control. Finally, the demo showed how pdf files can be located on and accessed from a remote PC. This provides for quite a bit more storage than internal memory of the PanelView Plus 7 terminal or even a SD card. This also provides for easier management of the pdf files since they are located in a centralized location.
Module 9 – Sending Email with an attachment using the EmailSender ActiveX and Print2PDF feature

Business Issue
Bert, Plant Manager at the Super Juice Company, is looking for a way to obtain an electronic copy of an End of Shift report to see how production is tracking against the target plan. He would like to obtain this report without having to physically access the terminal.

Solution
A new feature called Print2PDF, available in 8.00-20141224 and newer firmware for the PanelView Plus terminal will print an electronic copy. The application will also use the FactoryTalk® View Machine Edition Display Print feature to generate a screen capture and print it to a pdf stored on the PanelView Plus. The screen capture PDF file will then be attached to an email sent to the plant manager. Programming code within the SoftLogix 5800 has been used to allow for automation of this process as well as correct timing of the steps. These steps could also be performed by the operator using a manual multi-step procedure. Also note that this is only one example of how the EmailSender ActiveX and Print2PDF features could be used.

Demo

1. On the PanelView Plus 7 terminal, click the Login icon in the title bar of the Plant Summary display. Login using the Engineer account.
   - User name: en1
   - Password: en1

   The unlock icon will appear and user EN1 will display as the current logged in user.
2. Click the **Diagnostics** icon in the title bar to navigate to the Maintenance display.

3. Click the **Email** icon at the right of the Maintenance display to navigate to the EMAIL display.

4. Click the **Email Address Entry** string input enable button.
5. Enter 'manager@superjuice.com' using the on-screen keyboard.

The Email Address field will be populated with the Email address.

6. Click on the Print & Email Report button to begin the automated report generation process.

The application will automatically display the End of Day Report display for a brief period of time and then return to the EMAIL display.
On the EMAIL display you should see Mail Sent Successfully in the Email Status field.

If any configuration or transmission error occurs, the email message is not sent. An error message will appear in the Email Status field. Example:

It may take up to 1 minute before the Email Status is updated.

7. On the Lab PC, click **Start > Outlook 2013**.

8. Select the **Home** tab and click the arrow next to manager@superjuice.com to expand its options if it is not shown already.

9. Select the **Inbox** if this is not selected already. Note: the e-mail may also appear in the **Junk E-mail** folder.

10. Click the refresh icon in the upper right corner of Outlook if the Inbox does not contain the e-mail.
11. Click the Email link and double click the attachment to view it.

How To

Examining graphic displays used in this section

The **80 EMAIL** display shown below was created to allow configuration of the required **EmailSender** ActiveX options. The display is also the starting point for the operator to initiate the sending of emails to the plant manager.

[Image of the 80 EMAIL display]

The **81 Production Report** display shown below was created for the specific purpose of generating an end of production trend report for all four tanks of the process. The operator never interacts with this display during normal production, it is called remotely by the SoftLogix 5800 using the **Global Connection Remote Display Number** and is closed remotely once the display printing has occurred. At that time the operator is returned to the **80 EMAIL** display.

[Image of the 81 Production Report display]
For the purposes of this lab, we will focus on what is required to make the EmailSender ActiveX control work and not on the specific display creation.
Examine the EmailSender ActiveX Configuration

The **100 Startup Pop Up** display is loaded off screen at application startup to allow several ActiveX controls to be loaded in memory, the operator of the PanelView Plus terminal never sees this display.

1. Open the **100 Startup Pop Up** display by double clicking it.

2. Double click the Email ActiveX to bring up its properties.
3. Click the **Connections** tab to view the tags associated with the ActiveX control.

![ME EmailSender Control Properties](image)

The control uses an SMTP server to send an e-mail or text. Depending on the specific SMTP server, it may require a User ID, Password, SSL, and SSL port number. Or, it may send the e-mail anonymously and use the standard port number. This lab uses the ArGoSoft Mail Server as the SMTP server. The server is installed locally in the VM Ware image.

- **SMTPSrvrAddress** is 192.168.1.1 since it is loaded locally.
- **SMTPUserid** is the user name of the account for the ArGoSoft Mail Server.
- **SMTPUserPwd** is the password for the account for the ArGoSoft Mail Server.
- **SSLEnable** is set to a 0.
- **SMTPPort** is set to 25, which is the default SMTP port number.
- **From_Address** is set to the e-mail address of the account that is sending the e-mail. You will configure this as part of the lab.
- **From_Name** is the name of the person or entity sending the e-mail. You will configure this as part of the lab.

4. Close the **ME EmailSender Control Properties** window and the **100 Startup Pop Up** display. Select **No** if prompted to save any changes.
Configure four of the HMI tags required for the application

1. Open the HMI tag database and double click the \textit{SMTP} folder.

2. Select the \textit{From\_Address} tag and enter your own e-mail address for Initial Value. Click \textit{Accept} to save the changes.

3. Select the \textit{From\_Name} tag and enter your own name for Initial Value. Click \textit{Accept} to save the changes.
4. Select the **Server Address** tag and enter **192.168.1.1** for the **Initial Value**. Click **Accept** to save the changes.

5. Select the **Attachment Path** tag and enter **My Documents\TankReport.pdf** for the **Initial Value**. Click **Accept** to save the changes.

6. Close the HMI tag database.
Configure Global Connections

Global connections allow a data source to monitor or control run-time functions that apply to an entire project. For this lab two of the connections associated with the graphic display functionality (Remote Display Number & Remote Display Print) will be used to allow the SoftLogix 5800 to remotely control the application for a brief period of time.

1. Open **Global Connections** by double clicking it.

2. Select the **Display** tab.

3. Click the ellipse next to the **Remote Display Print** field to open the tag browser.

   The **Remote Display Print** Global Connection prints the currently visible display when the value changes from zero to a non-zero value. Everything on the screen is printed, including the current display, pop-up windows, and any visible background applications.
4. Click on **SuperJuicePartial** and then select the **RemoteDisplayPrint** tag as shown below, click **OK** when done.

![Tag Explorer screenshot]

5. Your **Global Connections** dialog should look like the one below, click **OK** to close the **Global Connections** dialog.

![Global Connections screenshot]
SoftLogix 5800 Configuration

The SoftLogix 5800 configuration has been done for you to allow proper automation and timing, below is an explanation of that process.

**SoftLogix 5800 Configuration**

Lines of code were configured in the Softlogix 5800 controller running locally. These lines of code automate the Display Print and EmailSender ActiveX process.

The steps below examine how that code functions:

Rung 0 – PanelView sets the **PrintReport** tag in the controller which triggers a remote display change to the **81 Production Report** display. When the PanelView switches to the **81 Production Report** display, a timer starts causing a delay while the display loads and collects trend data for 5 seconds. It also resets the Email trigger.

Rung 1 - When the first timer is done the **RemoteDisplayPrint** tag is triggered, the display print occurs using the **Remote Display Print Global Connection** and a second timer starts to allow time for the display print to save a PDF file to the PanelView Plus internal storage.

Rung 2 – When the second timer is done the **EmailTrigger** tag triggers the **EmailSender** ActiveX to send the email with the attachment and the operator is returned to the **80 EMAIL** display. It also resets the PrintReport tag which is tied to a maintain pushbutton.
PanelView Plus Print2PDF feature

Available in 8.00-20141224 and newer firmware, the Print2PDF option is accessible via the Print2PDF Config icon located on the Control Panel.

The Print2PDF Config dialog allows configuration of the PDF file created including both color type and resolution. These options would typically be used to control the PDF file size.

Note that the default name for the PDF output is TankReport.pdf. For the purpose of this lab the file location was configured as \My Documents.

Also note that the Print2PDF printer is now the default printer for the PanelView Plus terminal.

This scenario demonstrated how the Print2PDF feature can be used to create an electronic copy of a trend display. Additionally it was demonstrated how the pdf could be sent from the terminal using the SMTP ocx. These two features showed how a trend could be sent from the terminal at the end of each day.
Appendix – Creating a ‘Hello World’ Application

Creating a ‘Hello World’ Application
Completing this section requires approximately 20 minutes.

In this section, you will learn how to:

- Launch FactoryTalk® View Studio for Machine Edition
- Create a new project, configure project settings, and add content to the project
- Run the project on a PanelView™ Plus terminal.

Creating a FactoryTalk® Machine Edition Application

1. Using the Start menu select All Programs > Rockwell Software > FactoryTalk View > FactoryTalk View Studio item.

![Start menu screenshot]
2. Select **View Machine Edition** and click **Continue**.

![Application Type Selection](image)

The **New/Open Machine Edition Application** window will now appear:

![New/Open Machine Edition Application](image)

Note that the window may contain additional applications that are not shown in the above picture.

3. Click the **New** tab.

![New/Open Machine Edition Application](image)
4. In the **Application name** field, enter ‘**Intro**’

5. Next, click the **Create** button.

After creating the application, FactoryTalk® View Studio for Machine Edition opens the application:

If you are unfamiliar with FactoryTalk® View Studio for Machine Edition, please review the information in the next few pages.
Exploring FactoryTalk® View Studio for Machine Edition Interface

The FactoryTalk® View Studio for Machine Edition Application Window is divided into several key elements.

**Application Menu** - Used to interact with the application; Open/Close/Create new applications, Import/Export information, etc. The menu will change context based on what project object is open in the **Work Pane**.

**Graphics Toolbar** – Provides easy access to tools that are used to manipulate objects on a display (e.g., rotate, group, ungroup, etc.).

**Objects Toolbar** – Provides easy access to objects that are used on displays to create the user interface (e.g., Numeric Input, String Display, Momentary Push Button, etc.).

**Explorer Pane** – Contains all objects related to an application project. Application objects are then opened in the **Work Pane**. See more information regarding the portions of the Explorer Pan that will be used in this lab below.

**Diagnostic List** – Contains status and error messages related to the system application and project.

**Work Pane** – The work area where project objects are opened for manipulation and modification (e.g., displays, the tag database, object property windows, etc.).
Explorer Pane Components

The following portions of the Explorer Pane will be utilized by this lab. Information regarding the remaining components of this pane can be found in the Help file.

**System** – Contains project scope settings such as resolution, Security settings, Startup graphic files, and Diagnostic information.

**HMI Tags** – Contains all tags resident in the memory of the HMI server that are therefore not found in the Logix Controller project.

**Graphics** – Contains all graphic related components in the application, including displays, images, and the parameter files that can be utilized to reuse displays.

**Alarms** – Contains the application’s alarm configuration including triggers and messages.

**RSLogix Enterprise** – Contains communication shortcuts used by the application.

By default, new projects in FactoryTalk® view Studio for Machine Edition are configured for a PanelView™ Plus 700/1000 terminal with a 640x480 resolution. In this lab, the PanelView™ Plus 6 1250 terminal will be used, therefore, the project window size must be changed to match the terminal.

6. If the window is not already maximized, use the **maximize** button in the upper right-hand corner to do so.

7. Double-click the **Project Settings** item located in the top **System** container to open its dialog box.
8. Use the drop down list to select **PVPlus 1250 (800x600)**.

![Project Settings](image)

9. Click **OK** to accept the window size change.

The **Graphic Display Scaling** window will appear:

![Graphic Display Scaling](image)

This dialog gives the user the ability to determine which graphic components of the application will scale once the display size change has been accepted. Because this is a new project, leave the settings at default.

10. Click **OK** to continue the scaling process.
11. To view existing displays, expand the **Displays** container by clicking the **expander** from the **Explorer Pane** window.

When a new project is created, FactoryTalk® View ME 7.0 will automatically create four default displays, one of which is called **MAIN**, defined as the initial startup display. This display will be used for the following steps in the lab. When more displays are required, they can be added, as seen in a future section.

11. Double click on the **MAIN** display to open it.

The display will open in the **Work Pane** of FactoryTalk® View Studio for Machine edition.

A shutdown button is automatically created with each application. This button is used to shut down the application on the runtime device. When the application is shut down, that runtime device will close FactoryTalk® View Machine Edition Station.
**Adding Content to a Display**

In this section, a simple Text object will be added to the screen.

1. Select the Text object, and add a text box to the display by clicking the left mouse button and dragging the cursor to the right and down.

   ![Text object selection and dragging](image)

When you release the mouse button, the Text Properties dialog will open.

2. Click the Text field and enter **'Hello World! This is my Intro application.'**

   ![Text Properties dialog](image)

3. Click the OK button.
The display should now look similar to this:

4. Close the display using the **File > Close** menu item.

5. When prompted to save **MAIN**, click the **Yes** button.

Now that an object has been added to the **MAIN** display, verify that it is configured as the application’s **Startup** graphic.

6. To open the **Startup** dialog, double-click on the **Startup item** in the **System** container.
Notice the components that can be configured to execute when the application starts. Items such as Alarms and Information messages can be turned on or off, macros can be executed upon startup, and any display that has been created can be specified as the initial graphic.

Because **MAIN** is the only display that has been created, it is selected as the initial graphic by default.

6. Click **OK** to close the dialog.

**Creating the Runtime Application File**

In order to transfer the application to a PanelView™ Plus terminal, it first must be compiled into a Runtime Application File (*.mer). Follow the steps below to create the runtime file.

1. Select the **Application>Create Runtime Application** menu item.
Additional Runtime Application Options

The options available in the Conversion to development application section allow later recovery of the design files from the runtime project using the Application Manager.

Always allow conversion [Default] – The design information is always included with the runtime, so that it may be restored from the MER. The resulting MER requires more terminal memory to store the file.

Never allow conversion – Design information cannot be recovered from an MER created with this option selected. The MER created requires the least amount of terminal memory.

Conversion protected by password – When using Application Manager to extract the design information from the runtime file, the user will be prompted for the configured password. The resulting MER requires more terminal memory to store the file.

2. Save the runtime project using the suggestion name Intro.mer by clicking the Save button.

While FactoryTalk® View Studio for Machine Edition is creating the runtime MER file, a progress dialog will appear:

The runtime file has been created when the progress bar disappears.
Downloading a runtime MER to a PanelView™ Plus terminal

1. To download the runtime MER to the PanelView™ Plus terminal located at this workstation, first select the **Tools > Transfer Utility** menu item.

2. Click the **Source File Browse** button to select the runtime MER file to download.
This opens the Select File to Download dialog.

![Select File to Download dialog](image)

Note that the window may contain additional runtime files than those shown in the picture above.

3. Click on the **Intro.mer** file to select the project, then click **Open**.

![Select File to Download dialog](image)

The Source file is now updated with the **Intro.mer** directory:

```
C:\User\Public\Documents\RSView Enterprise\ME\Runtime\Intro.mer
```
4. Double-click the **EtherNet, Ethernet** driver to expand the item.

5. Select the **192.168.1.20, PanelView Plus_6 1250, PanelView Plus_6 1250** item by clicking on it once. Note that more devices may be shown in the list than shown in the picture below:

6. To initiate the download process, click the **Download** button.

7. If a message stating that the Intro application already exists on the terminal, click **Yes** to overwrite it. A progress dialog will then appear:

When the download process completes, a confirmation dialog is shown.

8. Click the **OK** button to acknowledge the dialog.

9. Click the **Exit** button to close the **Transfer Utility**.
Running an Application on a PanelView™ Plus Terminal

Use the steps below to load and run the Intro application on the PanelView™ Plus located at this station.

1. Tap on the PanelView™ Plus screen if the screensaver is active.

   The PanelView™ Plus desktop is now visible.

2. Locate the FTView ME Station icon on the desktop and double tap it to launch FactoryTalk® View ME Station.

3. Press the Load Application [F1] button.
4. Select the *Intro.MER* file from those available from the terminal's Internal Storage.

5. Press **Load [F2]** to load the runtime file into memory.

6. When prompted, press **Yes [F7]** to overwrite the terminal's current communication configuration with the configuration contained within the *Intro.MER* file.
7. Once successfully loaded, press the Run Application [F2] to start executing the runtime file.

![Run Application [F2]](image)

While the terminal is starting the application, an update dialog is displayed.

![Starting application, please wait...](image)

After the start up process completes, you should see your application’s startup display:

![Hello World! This is my V201 application.](image)

8. Click the Shutdown button to terminate the application.

Congratulations!

You have successfully created a FactoryTalk® View Studio for Machine Edition application, added application content, created a runtime file, downloaded the runtime file to a terminal and ran the application on a PanelView™ Plus terminal.
Applying Communications to an Application

Completing this section requires approximately 30 minutes.

In this section you will learn how to:
- Configure RSLinx® Enterprise Communications for an application.
- Add ‘Live’ object to a display.
- Testing an application using the Test Run Application functionality of FactoryTalk® View Studio

Configuring Communications

1. Return to the HMI project in FactoryTalk® View Studio and double click the RSLinx Enterprise item to expand.

2. Right-click on the Communication Setup item and select Open, or double click Communication Setup to launch the RSLinx Enterprise Configuration Wizard.

Note that this wizard can also be opened by double clicking Communication Setup.
The **Configuration Wizard** gives a user three options for configuring communications for the application:

**Create a new configuration** – Generates an empty communication configuration scheme for the application. This selection is enabled by default.

**Copy an existing configuration from a previously created project** – Reuses a communication configuration from a different application file.

**Copy the configuration that is currently running on this workstation** – Copies the communication configuration from an application currently hosted by FactoryTalk® View Machine Edition Station located on the same workstation.

3. Select the default **Create a new configuration** option, and click **Finish**.

The **Communication Setup** dialog will now appear:

![Communication Setup dialog](image)

Note that the window can be resized or maximized if desired.

**Exploring the Communication Setup dialog window**

The Communication Setup dialog has three main areas:

- **Device Shortcuts** – A list of shortcuts defined for this application
- **Network Path** – Displays the network topology path to the device associated with the selected shortcut, (e.g., ControlLogix processor, drive, etc.). This path is also used to define the network path for a selected shortcut.
  - **Design (Local)** – Configure the network and device path(s) for the development environment. This network configuration may be different than the production environment in which the application will ultimately run.
  - **Runtime (Target)** – Configure the network and device path(s) for the production environment.
- **Copy from Design to Runtime button** – Used when the Design and Runtime paths will be identical.
- **Offline Tag File** – Displays the hard drive path to the ACD file associated with the selected shortcut. This file is used for tag browsing when disconnected from a network.
5. To create a new shortcut, click the *Add* button in the *Device Shortcuts* area.

6. Name the shortcut by typing ‘Intro’ and then pressing the *Enter* key on the keyboard.

   The *Communication Setup* dialog should now look like this:

7. Expand the *EtherNet, Ethernet* driver by clicking the *expander* once.

8. Click the *expander* once to open the **192.168.1.1, SoftLogix 5800 EtherNet/IP, SoftLogix 5800 EtherNet/IP** item.
9. Click the \textit{expander} \textcolor{red}{+] to open the \textbf{1789-A17/A, 1789-A17/A Virtual Chassis} item.

10. Select \textbf{2, 1789-L60/A, BlockMachine} by clicking on it once. The dialog should now look like this:

11. Click the \textbf{Apply} button above the \textbf{Device Shortcuts} pane to associate the SoftLogix 5800 Controller with the selected communication shortcut \texttt{Intro}. 

---

128 of 150
12. Click the Yes button to confirm the association.

In this lab, the design and production environments are identical. To proceed you have two options:

A. Use the Copy from Design to Runtime button to copy the design environment topology and device paths to the production environment (e.g. Runtime (Target) tab). It is estimated this option will require less than 5 minutes to complete.

B. Manually configure the production environment so that you understand how this functionality works. It is estimated manual configuration will require 5 to 10 minutes to complete.

Choose either Option A or Option B.

Option A

1. Click the Copy from Design to Runtime button to copy the communication configuration from the Design (Local) tab to the Runtime (Target) tab.

2. When prompted, click Yes to confirm the operation.
3. Click on the **Runtime (Target)** tab to select it.

If necessary, use the expanders to open the topology items (e.g. drivers and devices) to confirm that the Design (Local) configuration have been replicated.

4. Click the **Verify** button to confirm the Design and Runtime associations.

Confirm both the Design and Runtime devices are assigned to shortcut **Intro**.
5. Close the **Shortcut Verifier** dialog by clicking the **Close** button.

6. Click the **OK** button to complete the communication setup and close the **Communication Setup** dialog.

Be sure to use the **OK** button! If you close the dialog with the **X**, the communication setup with **not** be saved to the application.

**Option B**

1. Click on the **Runtime (Target)** tab to select it.

2. Right-click on **EtherNet, Ethernet** item to open the context menu, and select **Add Device**.
3. Click **Add Device** which opens the **Add Device Selection** dialog.

4. Expand the **EtherNetIP Devices** item by clicking the **expander**.

5. Select the **expander** next to **SoftLogix 5800 EtherNet/IP**.

6. Select **SoftLogix 5800 EtherNet/IP, Major Revision 21**.

7. Click the **OK** button to accept the selection. This action opens the **Device Properties** dialog.
8. Enter ‘**192.168.1.1**’ in the **Address** field to set the device’s TCP/IP address.

9. Change the selected **Slot** to 3.

10. Click the **OK** button to add the device to the **Runtime (Target)** configuration.

11. Use the expander to open the **192.168.1.1, SoftLogix5800 EtherNet/IP, SoftLogix 5800 EtherNet/IP** device.

12. Right-click the **1789-A17, 1789-A17 Virtual Chassis** item and select **Add Device**.
13. Expand the **1789-L60/A, 1789-L60/A SoftLogix 5860 Controller** item by clicking.

14. Select the **1789-L60/A SoftLogix 5860 Controller, Major Revision 21** item.

15. Click the **OK** button to accept the selection.
16. Change the controller's **Slot** property to 2.

17. Click the **OK** button to add the device to the **Runtime (Target)** configuration.

18. Click the **Apply** button in the **Device Shortcuts** pane.

19. Click the **Yes** button to apply the changes to the **Intro** shortcut.
20. Click the **Verify** button to confirm the Design and Runtime associations.

![Shortcut Verifier](image)

Confirm both the Design and Runtime devices are assigned for shortcut **Intro**.

21. Close the **Shortcut Verifier** dialog by clicking the **Close** button.

Be sure to use the **OK** button! If you close the dialog with the **X**, the communication setup with **not** be saved to the application.

---

**Adding ‘Live’ Objects to a Display**

Now that a communication path to a controller is configured, you are ready to add objects (buttons, numeric displays, etc.) to the display that use information from the controller. The lab uses a variety of different buttons, data displays, and images to illustrate FactoryTalk® Machine Edition functionality and application capabilities.

1. Double-click the **MAIN** display in the **Explorer** to open the display.

   ![Explorer](image)

2. Select the **Numeric Display** tool from the **Objects** toolbar, or select **Objects>Numeric and String>Numeric Display**.
3. Move the mouse cursor onto a free area of the **MAIN** display frame; click and hold the left mouse button, and then drag down and to the right to create a **Numeric Display** object.

4. Position the cursor over the **Numeric Display** and double-click the mouse to open the **Numeric Display Properties** dialog.

5. Click the **Common** tab.

6. Change the **Height** and **Width** fields to size the Numeric Display exactly.
   - Height: 50
   - Width: 100

7. Click the **Apply** button to commit these changes. The button should move and resize on the display to match these settings.
   If you accidentally clicked **OK** button, simply reopen the button’s property dialog by double-clicking the button.

8. Click the **Connections** tab.
9. In the **Value** row, click the **Browse** button in the **Tag** column to open the **Tag Browser**.

This action opens the **Tag Browser**.

The **Tag Browser** is used to view and select tags from the device selected in the **RSLinx Enterprise** setup earlier in the lab.

**Sections of the Tag Browser**

Three portions of the tag browser should be noted:

- **Folders** – Used to browse a shortcut’s Controller and Program tags, as well as User Defined Tags
- **Tags** – Used to select a specific tag from the selected folder
- **Tag Filter** – Shows only those tags that start with the filter entered by the user. Pressing Enter will apply the filter to the tag area.
28. Right-click on the **Intro** item in the **Folders** list; select the **Refresh All Folders** item.

Alternatively, you can use the **Refresh All Folders** button, located near the bottom of the Tag Browser:

29. Double click the **Intro** folder, then double click the **Online** folders to expand them.

30. Scroll down, and expand **Program:Tank**, then expand **Tank** and click **Tank[0]**.
31. In the Tag Area, locate and select the tag **Level**.

The Name column of the tags area may need to be resized in order to read the full tag name.

![Tag Browser](image)

Note that the **Selected Tag** text box reflects your selection.

32. Click **OK** to complete the Connection configuration.

![Numeric Display Properties](image)

Notice the Value connection has been updated with the path to the tag specified using the tag browser.

14. Click **OK** again to close the property dialog.

The button has now been updated with all the changes made in the property dialog.

This display should look similar to the following:
16. Save the **MAIN** display using the *File* > *Save* menu item.

17. Close the **MAIN** display.

**Testing an application on the Desktop**

Testing an application can be performed by downloading and running it on a PanelView™ Plus terminal. However, to save time, it is possible to test the full application on the Desktop. This can be done using the emulation capability included in FactoryTalk® View Studio for Machine Edition. The following steps will walk through testing the application on the Desktop.

1. From the **Application** menu, select the **Test Application** item.

   The system will build the runtime MER.
When the runtime MER file is built, the system loads the runtime MER into an emulation mode. The application will appear in the upper left-hand corner of the computer monitor.

2. Click on the Shutdown button to end the emulation.
   Alternatively, press X on your keyboard to close the test application.

Congratulations!!

You have successfully added 'live' content; configured communications with a controller; created a runtime file; and exercised the application on your desktop.
## Lab Setup and Configuration Information

### Lab Information

<table>
<thead>
<tr>
<th>Lab Name</th>
<th>New Techniques to Increase Efficiency with PanelView™ Plus 6 Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab Description</td>
<td>Demo highlighting some of the features in FTView ME 8.00 &amp; PanelView™ Plus 6 2.23 OS &amp; a how to section describing how the demo was created.</td>
</tr>
<tr>
<td>Lab Creator</td>
<td>Wil Mattheis</td>
</tr>
<tr>
<td>Date Created</td>
<td>09-11-2014</td>
</tr>
</tbody>
</table>

### Hardware Configuration

<table>
<thead>
<tr>
<th>Qty</th>
<th>Demo Cat.# / Description</th>
<th>Communication</th>
<th>Location</th>
<th>Firmware</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2711P-RP9A ser A or later / PanelView Plus 6 logic module</td>
<td>ethernet</td>
<td></td>
<td>8.00 w/ 2.23 OS</td>
</tr>
<tr>
<td>1</td>
<td>2711P-RDT12C ser C or later / PanelView Plus 1250 display module</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Ethernet crossover cable</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Computer/Host Settings

<table>
<thead>
<tr>
<th>Location</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Name</td>
<td>WIN7-VM-AF2014</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 7</td>
</tr>
</tbody>
</table>
Basic Setup Diagram

Student Station

PanelView Plus 6 1250

NIC 2
Host computer TCP/IP setting: DHCP
VMWare image TCP/IP setting: IP Addr 192.168.1.1
Subnet 255.255.255.0

NIC 1
Host computer TCP/IP setting: DHCP

IP Addr: 192.168.1.20
Subnet: 255.255.255.0

CAT5E cross-over cable

To Classroom network
DHCP assigned IP

CAT5E cable
### Application/Programming

<table>
<thead>
<tr>
<th>Location</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Lab Files\crease Efficiency with PanelView™ Plus 6 Applications\PVP6</td>
<td>SuperJuiceDemo.mer Batch file to update the PVP6 firmware and to place the CSV, HTM, and pdf files into My Documents on the terminal</td>
</tr>
<tr>
<td>C:\Lab Files\ SoftLogix</td>
<td>SuperJuice.ACD</td>
</tr>
<tr>
<td>C:\Lab Files\ FTView ME</td>
<td>SuperJuiceDemo.apa SuperJuicePartial.apa</td>
</tr>
</tbody>
</table>

### Additional Equipment Required

<table>
<thead>
<tr>
<th>Qty</th>
<th>Items</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### RSLinx - DDE/OPC Topic Configuration

<table>
<thead>
<tr>
<th>Topic Name</th>
<th>Path to Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>n/a</td>
<td></td>
</tr>
</tbody>
</table>

### RSLinx - Driver Configuration

<table>
<thead>
<tr>
<th>Topic Name</th>
<th>Path to Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>AB_VBP-1 (no topic required)</td>
<td>Virtual Backplane driver to access the SoftLogix processor</td>
</tr>
</tbody>
</table>
### RSLinx Enterprise - Shortcut Configuration

<table>
<thead>
<tr>
<th>Topic Name</th>
<th>Path to Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>SuperJuice</td>
<td>Through SoftLogix Ethernet IP module in slot 3 to SoftLogix processor in slot 2, Ethernet, Ethernet &gt; 3, 192.168.1.1 &gt; Backplane &gt; 2, 1789-L60 v21</td>
</tr>
</tbody>
</table>

### Application Versions

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Software</th>
<th>Version</th>
<th>Service Pack</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>FactoryTalk View Machine Edition Studio</td>
<td>8.00.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FactoryTalk Services Platform</td>
<td>2.70</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RSLinx Enterprise</td>
<td>5.70</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RSLinx Classic</td>
<td>3.70</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Studio 5000</td>
<td>21.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SoftLogix 5800</td>
<td>21.03</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FactoryTalk® ViewPoint</td>
<td>8.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel 2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Silverlight</td>
<td>5.1.30514.0</td>
<td></td>
</tr>
</tbody>
</table>
Required Pre-Lab Configuration

Configure the Virtual Network

Select Virtual Network Editor from the Edit menu to open the Virtual Network Editor dialog.

The dialog below will appear.
Select the Host Virtual Network Mapping tab.

For VMnet0 select the physical ethernet adapter that will be connected to the PanelView Plus terminal.

Click the OK button to commit the changes that have been made.